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บทท่ี 3 
วิธีดำเนินการวิจัย 

 
3.1 ขั้นตอนการดำเนินงานวิจัย 

3.1.1 การออกแบบการทดสอบการหล่อ 

งานวิจัยนี้ต้องการต้องศึกษาอิทธิพลของบิสมัทที่มีผลต่อโครงสร้างจุลภาคและสมบัติ

เชิงกลของเหล็กหล่อเหนียว มีขั้นตอนในการดำเนินงานวิจัยแสดงดังรูปที่ 3.2 โดยใช้เทคนิคการหล่อ

เหล็กหล่อเหนียวขึ้นมาทั้งหมด 5 ชุด ตามตารางที่ 3.1 โดยแต่ละชุดมีการเติมบิสมัทที่แตกต่างกัน 

ตั้งแต่ 0 ถึง 0.01% ตามน้ำหนัก ซึ่งในการออกแบบการทดสอบการหล่อชิ้นงานตัวอย่างจะมีทั้งหมด 

2 ประเภท ดังต่อไปนี้ 

1) การออกแบบแรกคือการหล่อทรงกระบอกสำหรับการทดสอบแรงดึง  ตาม
มาตรฐาน ASTM E8 ขนาดเส้นผ่านศูนย์กลางงานหล่อ 25.4 มิลลิเมตร 

2) การออกแบบประเภทที่สองคือการหล่อแบบขั้นบันได (Step pattern) ซึ่งจะมี
ความหนาแตกต่างกัน ตั้งแต่ 4 9 16 25 และ 36 มิลลิเมตร ตามลำดับ ดังรูปที่ 3.1  

นอกจากนี้ยังได้นำซอฟต์แวร์จำลองการหล่อเชิงพาณิชย์ มาใช้เพ่ือประมาณอัตรา

การเย็นตัวทีส่อดคล้องกับความหนาของส่วนต่างๆ อีกด้วย  

 

 
 

รูปที่ 3.1 ขนาดของการหล่อแบบขั้นบันได 

 

 

 



    34 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
   

 

รูปที่ 3.2 ขั้นตอนการดำเนินงานวิจัย 

รวบรวมปรทิศัน์วรรณกรรมทีเ่กีย่วขอ้งกบังานวจิยันี้ 

เลอืกวธิกีารทดลอง เครื่องมอืและวสัดุทีใ่ชใ้นการวจิยั 

ออกแบบชิน้งาน จ าลองการหล่อและวางแผนการหลอม 

จดัเตรยีมเครื่องมอื และเตรยีมวตัถุดบิส าหรบัการด าเนินการทดลอง 
 

ทดลองหลอมชิน้งานเพื่อศกึษาผลของบสิมทัทีม่ตี่อโครงสรา้งจลุภาคและสมบตัเิชงิกล 

ตรวจสอบส่วนผสมทางเคม ี

วเิคราะหท์างกายภาพ 

และโครงสรา้งจุลภาค 

 

วเิคราะหผ์ลและสรุปผล เพื่อเขยีนรายงาน 

 

ปรบัปรุง 

ส่วนผสมทางเคม ี
วเิคราะห ์

ทางความรอ้น 

หล่อชิน้งานทดสอบ ชิน้งานทรงกระบอก 

ชิน้งานขัน้บนัได ทดสอบสมบตัเิชงิกล 
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ตารางที่ 3.1 สรุปเงื่อนไขการทดลอง 
เงื่อนไข ความหนา (มิลลิเมตร) จำนวนบิสมัท (%น้ำหนัก) 

เหล็กหล่อเหนียว 

4 0, 0.003, 0.005, 0.007, 0.010 

9 0, 0.003, 0.005, 0.007, 0.010 

16 0, 0.003, 0.005, 0.007, 0.010 

25 0, 0.003, 0.005, 0.007, 0.010 

36 0, 0.003, 0.005, 0.007, 0.010 

 

3.2 วัสดุที่ใช้ในการวิจัย 
3.2.1 เหล็กดิบ (Ductile Pig iron) เป็นวัตถุดิบตั้งต้นสำหรับการผลิตเหล็กหล่อเหนียว จะ

ใส่ลงไปในเตาหลอมเป็นลำดับแรก โดยต้องเผาไล่ความชื้นในเหล็กก่อนนำลงไปในเตาหลอม  
3.2.2 เหล็กกล้า (Steel) เป็นวัตถุดิบที่ใส่ลงไปเพื่อช่วยลดปริมาณคาร์บอนของเหล็ก

หลอมเหลว ในกรณีที่เหล็กหลอมเหลวนั้นมีคาร์บอนเกินความต้องการ 
3.2.3 เฟอร์โร-ซิลิคอน-แมกนีเซียม (Fe-Si-Mg alloy) เป็นวัตถุดิบที่เติมลงไปในเหล็ก

หลอมเหลว เพื่อเปลี่ยนรูปทรงของแกรไฟต์เป็นรูปทรงกลม  (Spheroidal Graphite) การเปลี่ยน

รูปร่างของแกรไฟต์นั้นขึ้นอยู่กับปริมาณของแมกนีเซียม 

3.2.4 ผงคาร์บอน (Carbon) เป็นว ัตถุด ิบที ่ เต ิมเพื ่อเพิ ่มปริมาณคาร์บอนใน เหล็ก

หลอมเหลว ผงคาร์บอนที่เติมมักมีเปอร์เซ็นคาร์บอนไม่น้อยกว่า 99% 

3.2.5 บิสมัทบริสุทธิ์ (Pure Bismuth) เป็นวิตถุดิบที่เติมเพื่อเพิ่มปริมาณบิสมัทในเหล็ก

หลอมเหลวให้มีปริมาณคาร์บอนตามเง่ือนไขที่กำหนด ดังรูปที่ 3.3 

3.2.6 สารอินนอคคูแลนต์ เป็นวัตถุดิบสำหรับการทำอินนอคคูเลชั่น ในน้ำเหล็ก ซึ่งสารอิน
นอคคูแลนต์ที่ใช้ไดใ้นการทดลองนี้ได้แก่ Superseed75 inoculant โดยมีส่วนผสมตามตารางที่ 3.2 
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ตารางที่ 3.2 ส่วนผสมทางเคมีของวัตถุดิบที่ใช้ในการหล่อเหล็กหล่อเหนียว  

Materials %C %Si %Mn %P %S 

Ductile Pig iron 4.439 0.61 0.062 0.058 0.028 

Steel scrap 0.191 0.284 0.359 0.0082 0.0018 

 

Materials %C %Si %Mg %Ca %Re %Al %S 

Ferro silicon magnesium - 48.0 5.1 - - 0.8 - 

 

Materials %Si %Ba %Ca %Sr %Al %Zr %Ce 

Superseed 75 inoculant 73-78 - 0.1 Max 0.6-0.1 0.5 Max - - 

 

 

 

 

 

 

 

Pig Iron 

 

 

 

 

 

 

Steel scrap 
Fe-Si-Mg alloy 

 

 

 

 

 

 

Carbon 

 

 

 

 

 

 

Pure Bismuth 

 

 

 

 

 

 

Superseed75 inoculant 

 

รูปที่ 3.3 วัสดุที่ใช้ในการทดลอง 
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3.3 อุปกรณ์และเครื่องมือที่ใช้ในการทดลอง 

          3.3.1 เตาหลอมโลหะประเภทไฟฟ้ากระแสเหนี่ยวนำ (Electric Induction Furnaces) 

เป็นเครื่องมือที่ใช้ในการหลอมละลายก้อนเหล็กดิบ ก่อนจะมีการเติมส่วนผสมอื่นลงไปให้น้ำโลหะ

หลอมเหลว เพื่อให้ได้ส่วนผสมทางเคมีตามเงื่อนไขที่ต้องการ โดยเตาหลอมมาพร้อมชุดควบคุมการ

จ่ายพลังงานไฟฟ้าสามารถจ่ายกำลังไฟฟ้าสูงสุดได้ที่ 100 kVA แสดงดังรูปที่ 3.4 

 
รูปที่ 3.4 เตาหลอมและตู้ควบคุม 

          3.3.2 เครื ่องโม่ทราย เครื ่องบดทราย (sand mill) คือเครื ่องจักรที ่ใช้สำหรับโม่หรือ

กระจายตัวทราย เพื่อให้ได้เม็ดทรายที่มีขนาดละเอียดและสม่ำเสมอ เหมาะสำหรับการใช้งานใน

กระบวนการผลิต เช่น การหล่อโลหะ การผลิตกระเบื้อง หรือการใช้งานในอุตสาหกรรมอื่น ๆ ที่

ต้องการทรายละเอียดคุณภาพสูง เครื่องโมท่รายมักมีหลายรูปแบบและขนาด ขึ้นอยู่กับลักษณะการใช้

งานและประเภทของวัสดุที่ต้องการบด ดังรูปที่ 3.5 

 
รูปที่ 3.5 เครื่องโม่ทราย 
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          3.3.2 หีบแบบและทรายแบบ เป็นอุปกรณ์และวัสดุที่ใช้ในการทำแม่พิมพ์สำหรับการหล่อ

โลหะ หีบแบบ (mold) คือโครงสร้างที่ใช้ในการสร้างรูปทรงของชิ้นงาน โดยทั่วไปมักทำจากโลหะ

หรือวัสดุแข็งอื่น ๆ ส่วนทราย (sand) ใช้เป็นวัสดุทำแม่พิมพ์ในกระบวนการหล่อโลหะ โดยเฉพาะใน

การหล่อเหล็กหรืออลูมิเนียม ทรายที่ใช้หล่อมักมีการผสมสารเคมีเพื่อเพิ่มความแข็งแรงและความ

ทนทานในการใช้งาน ดังรูปที่ 3.6 

 

          
รูปที่ 3.6 ทรายแบบ (ซ้าย) หีบแบบ (ขวา) 

 

3.3.3 ชุดอุปกรณ์วัดอุณหภูมิที่ประกอบไปด้วยเทอร์โมคัปเปิลประเภท S ใช้ในการวัด

อุณหภูมิน้ำโลหะหลอมเหลวก่อนเทลงในแม่พิมพ์ ดังแสดงในรูปที่ 3.7  

 
รูปที่ 3.7 ชุดอุปกรณ์วัดอุณหภูมิ (ที่มา : http://th.qrdetecting.com และ https://nakayama-

meps.co.jp/english/thermometer/index.html) 

 

 

http://th.qrdetecting.com/
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3.3.4 แก๊สเผาแบบ (gas-fired mold) เป็นเชื้อเพลิงในการให้ความร้อนกับแม่พิมพ์ เพ่ือ

ทำให้แม่พิมพ์ร้อนและพร้อมใช้งานในการหล่อโลหะ การเผาแม่พิมพ์ด้วยแก๊สช่วยเพ่ิมความแม่นยำใน

การควบคุมอุณหภูมิ ทำให้แม่พิมพ์มีความทนทานและให้ผลลัพธ์ที่ดีกว่าในกระบวนการผลิต ดังรูปที่ 

3.8 

 
รูปที่ 3.8 แก๊สสำหรับเผาแบบ 

 

3.3.5 เบ้ารองรับน้ำโลหะ (Ladle) เป็นเบ้าที่รองรับน้ำโลหะจากเตาหลอมโลหะ และเป็นที่

ใช้ในการผสมสารโนดูลลาไรเซอร์ (Nodularizer) หรือสารอินน็อคคูแลนต์ก่อนเทลงแบบหล่อ ดัง

แสดงในรูปที่ 3.9 

 
รูปที่ 3.9 เบ้ารองรับน้ำโลหะ (Ladle) 
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3.3.6 ชุดอุปกรณ์สำหร ับชักต ัวอย ่างน ้ำโลหะ ประกอบไปด้วยแม่พ ิมพ์ท ี ่ทำด้วย

โลหะทองแดงและเบ้ารองรับน้ำโลหะสำหรับชักตัวอย่างแบบเหรียญ ก่อนที่จะนำไปตรวจสอบ

ส่วนผสมทางเคมีด้วยเครื่องสเปกโตรมิเตอร์ (Optical emission spectrometers) ดังแสดงในรูปที่ 

3.10 และรูปที่ 3.11 

 
รูปที่ 3.10 แม่พิมพ์ทองแดงสำหรับรองรับการชักตัวอย่างน้ำโลหะ 

 

 
รูปที่ 3.11 เบ้ารองรับน้ำโลหะสำหรับชักตัวอย่าง 

 

3.3.7 เครื่องชั่งน้ำหนักแบบหยาบและเครื่องดิจจิทัล (ชั่งละเอียด) สำหรับเครื่องชั่งหยาบ

ใช้สำหรับชั่งเหล็กดิบ (Pig iron) และเศษเหล็กกล้าก่อนก่อนใส่เตาหลอมและเครื่องชั่งละเอียดนั้นใช้

สำหรับชั่งวัตถุดิบต่าง ๆ   ลงสู่เตาหลอม เพ่ือปรับส่วนผสมทางเคมีของน้ำโลหะ ดังแสดงในรูปที่ 3.12 
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รูปที่ 3.12 เครื่องชั่งน้ำหนักแบบหยาบ (ซ้าย) เครื่องชั่งน้ำหนักแบบละเอียด (ขวา) 

 

3.3.8 เครื่องตรวจสอบส่วนผสมทางเคมี หรือที่เรียกว่าสเปกโตรมิเตอร์ (Optical emission 

spectrometers) เป็นเครื่องในการตรวจสอบส่วนผสมทางเคมี ในขณะที่ทำการหล่อหลอมและก่อน

เทน้ำโลหะลงแม่พิมพ์เพ่ือตรวจสอบส่วนผสมทางเคมีของน้ำโลหะ แสดงในรูปที่ 3.13 

 
รูปที่ 3.13 เครื่องตรวจสอบส่วนผสมทางเคมี 

 

3.3.9 อุปกรณ์สำหรับการวัดอัตรากาเย็นตัวของเหล็กหล่อเหนียว ประกอบไปด้วย 

3.3.9.1 เทอร์โมคัปเปิลประเภท S ที่สามารถวัดอุณหภูมิได้สูงถึง 1600 °C ซึ่งจะต่อ

เข้ากับระบบเก็บข้อมูล (Digital data acquisition system) แสดงในรูปที่ 3.14 
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รูปที่ 3.14 อุปกรณ์สำหรับการวัดอัตราการเย็นตัวของเหล็กหล่อเหนียว 

 

3.3.9.2 ระบบเก็บข้อมูลแบบดิจิตอล (Digital data acquisition system) เป็น

อุปกรณ์ในการเก็บระบบข้อมูลจาก Transducer และ Thermocouple ซึ่งตัวระบบเก็บข้อมูลนั้นจะ

เชื่อมต่อกับคอมพิวเตอร์โน้ตบุ๊กเพ่ือแสดงผลการทดลอง แสดงในรูปที่ 3.15 

 

 
รูปที่ 3.15 ระบบเก็บข้อมูลแบบดิจิตอล (Digital data acquisition system) 

 

3.3.9.3 คอมพิวเตอร์โน้ตบุ๊ก เป็นอุปกรณ์ทำหน้าที่เป็นจอแสดงผลการทดลองที่

ได้มาจากระบบเก็บข้อมูลแบบดิจิตอล แสดงในรูปที ่3.16 

 

เทอรโ์มคปัเปิล S 



    43 

 

 
รูปที่ 3.16 คอมพิวเตอร์โน้ตบุ๊กเพ่ือแสดงผล 

 

3.3.10 เครื่องตัดเหล็ก (Steel Cutting Machine) เป็นเครื่องจักรที่ใช้สำหรับตัดเหล็กและ

วัสดุโลหะต่างๆ โดยทั่วไปมีหลายประเภทที่ออกแบบมาเพื่อรองรับการตัดในรูปแบบและขนาดที่

แตกต่างกัน แสดงในรูปที่ 3.17 

 

 
รูปที่ 3.17 เครื่องตัดเหล็กเพ่ือใช้ในการตัดชิ้นงาน 

 

3.3.11 เครื่องขัดผิวชิ้นงาน สำหรับเตรียมผิวชิ้นงานให้เรียบเนียนหรือขจัดคราบสนิม และ

ความไม่เรียบของพื้นผิว ช่วยให้ชิ ้นงานมีคุณภาพและความสวยงามที่ดีขึ ้น เพื ่อนำมาใช้ในการ

ตรวจสอบโครงสร้างจุลภาค แสดงในรูปที่ 3.18 
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รูปที่ 3.18  เครื่องขัดผิวชิ้นงาน 

 

3.3.12 กล้องจุลทรรศน์แบบใช้แสงพร้อมอุปกรณ์การถ่ายภาพ (Optical Microscope with 

Imaging Equipment) เป็นเครื่องมือที่ใช้ในการขยายภาพวัตถุขนาดเล็กโดยใช้แสง เพ่ือให้มองเห็น

รายละเอียดที่ไม่สามารถมองเห็นด้วยตาเปล่าได้ โดยมีการติดตั้งอุปกรณ์ถ่ายภาพเพ่ือบันทึกภาพหรือ

วิดีโอของสิ่งที่สังเกตได้ ใช้ในการตรวจสอบลักษณะของโครงสร้างจุลภาคภายหลังการหล่อ ดังแสดงใน

รูปที่ 3.19   

 
รูปที่ 3.19 กล้องจุลทรรศน์แบบใช้แสงพร้อมชุดอุปกรณ์ถ่ายภาพ 

 

3.3.13 เครื่องกลึงเหล็ก (Metal Lathe) คือเครื่องจักรที่ใช้สำหรับการขึ้นรูปและแปรรูป

เหล็กและโลหะอ่ืน ๆ ให้เป็นชิ้นงานที่มีรูปทรงต่าง ๆ โดยการหมุนวัสดุรอบแกนหมุนและใช้เครื่องมือ
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ในการตัด เจาะ หรือขัดพื้นผิว เครื่องกลึงเหล็กมีหลายประเภทและสามารถใช้ในงานหลากหลาย

ประเภท ตั้งแต่งานผลิตชิ้นส่วนขนาดเล็กจนถึงงานผลิตชิ้นส่วนขนาดใหญ่ในอุตสาหกรรมหนัก  ดัง

แสดงในรูปที่ 3.20 

 
รูปที่ 3.20 เครื่องกลึงเหล็กอัตโนมัติ 

3.3.14 เครื่องทดสอบความแข็ง (Hardness Tester) เป็นเครื่องมือที่ใช้ในการวัดค่าความ

แข็งของวัสดุ ซึ่งเป็นการประเมินความทนทานของวัสดุต่อการเกิดรอยบุ๋มหรือการเสียรูปแบบถาวร

เมื่อมีแรงกด เครื่องทดสอบความแข็งมีหลายประเภทที่ใช้วิธีการวัดที่แตกต่างกันออกไป เช่น วิธีการ

ทดสอบความแข็งแบบบริเนล (Brinell), ร็อคเวล (Rockwell), วิกเกอร์ส (Vickers) และอื่น ๆ ดัง

แสดงในรูปที่ 3.21 

 
รูปที่ 3.21 เครื่องทดสอบความแข็ง 
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3.3.15 Electron Probe Micro Analyzer (EPMA) เป ็นเคร ื ่องม ือในการว ิ เคราะห ์ว่า

องค์ประกอบใดบ้างที่ประกอบเป็นสสาร โดยการฉายรังสีลำอิเล็กตรอนลงบนพื้นผิวของสารและวัด

ลักษณะเฉพาะของรังสีเอกซ์ที่สร้างขึ้น  ดังแสดงในรูปที่ 3.22 

 
รูปที่ 3.22 เครื่อง Electron Probe Micro Analyzer (EPMA) (ที่มา: https://www.jeol.com/  

products/science/epma.php) 

 

3.3.16 เครื่องทดสอบแรงดึง (Tensile Testing Machine) เป็นอุปกรณ์ที่ใช้ในการทดสอบ

แรงดึงของวัสดุต่าง ๆ โดยการดึงวัสดุให้ยืดออกจนถึงจุดที่วัสดุนั้นแตกหรือขาด การทดสอบนี้ช่วยใน

การวัดคุณสมบัติทางกลของวัสดุ เช่น ความแข็งแรง ความยืดหยุ่น และความทนทาน ดังแสดงในรูปที่ 

3.23 

 
รูปที่ 3.23 เครื่องทดสอบแรงดึง 

3.4 ขั้นตอนการหล่อเหล็กหลอ่เหนียว 

https://www.jeol.com/
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3.4.1 เตรียมชั่งน้ำหนักวัตถุดิบและเตรียมอุปกรณ์ไว้สำหรับการหล่อ 

3.4.2 จากนั้นผสมทรายแบบและตำแบบทั้ง 2 ชิ้นงานเพื่อชิ้นงานขั้นบันไดและชิ้นงาน

ทรงกระบอก ดังรูปที่ 3.24 

 
รูปที่ 3.24 ขั้นตอนการตำแบบหล่อ 

 

3.4.3 นำเหล็กดิบ (Ductile Pig iron) ที่เตรียมไว้ใส่เตาหลอมและทำการเปิดเตาหลอม

โลหะ เมื่อเหล็กหลอมเหลวแล้วก็ทำการปรุงส่วนผสมทางเคมีตามเงื่อนไขที่กำหนด โดยจะทำการ

หลอมทั้งหมด 5 ชุด ดังตารางที่ 3.3  

3.4.4 หลังจากการปรุงส่วนผสมทางเคมีเป็นที่เรียบร้อยแล้ว จะต้องตรวจสอบส่วนผสม

ทางเคมี โดยเทน้ำเหล็กลงบนแท่นทองแดงเพื่อนำเหรียญตัวอย่างไปตรวจสอบส่วนผสมทางเคมีด้วย

เครื่องสเปกโตรมิเตอร์ (Spectrometer) และคำนวณค่าคาร์บอนสมมูล (Carbon equivalent, CE) 

ให้ตรงตามความต้องการ หากน้ำเหล็กมีปริมาณคาร์บอนที่มากเกินจะทำการเติมเหล็กกล้า  เพื่อลด

ปริมาณคาร์บอนในน้ำเหล็ก หรือถ้ามีปริมาณซิลิคอนในน้ำเหล็กมีมากจะต้องเติมเหล็กดิบเพื่อลด

ปริมาณซิลิคอน 

3.4.5 สำหรับการจะทำให้แกรไฟต์กลมนั้น จะต้องเติมสารเฟอร์โร -ซิลิคอน-แม็กนีเซียม 

อินน็อคคูแลนต์ และบัสมัทบริสุทธิ์หลังจากการกำจัดออกซิเจน เหล็กหลอมเหลวจะถูกทำให้ร้อน

จนถึงอุณหภูมิสูง และถูกเทออกที่ประมาณ 1500°C และ 1450°C ตามลำดับ มายังเบ้ารองรับน้ำ
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โลหะ (Ladle) หลังจากทำอินน็อคคูเลชันแล้วควรเทน้ำเหล็กใส่แบบหล่อ ทันทีเพื่อป้องกันการจาง

หายไปของสารอินน็อคคูแลนต์ ดังรูปที่ 3.25 

    
รูปที่ 3.25 การเทน้ำเหล็กมายังเบ้ารองรับน้ำโลหะเพ่ือทำการอินน็อคคูเลชัน 

 

3.4.6 เมื่อเทน้ำโลหะลงสู่แบบหล่อทั้งสองแบบที่อุณหภูมิ 1380 ˚C เรียบร้อยแล้ว รอให้

ชิ้นงานแข็งตัวหลังจากนั้นทำการรื้อแบบ          
3.4.7 ทำการวัดขนาดชิ้นงานภายหลังการแข็งตัว เพื่อหาขนาดชิ้นงานที่เปลี่ยนแปลงไป 

โดยใช้การวัดเพ่ือหาค่าเฉลี่ยและวัดน้ำหนักที่เปลี่ยนแปลงไปเพ่ือคำนวณหาปริมาตรที่หายไป 
3.4.8 นำชิ้นงานที่ได้จากการหล่อแบบขั้นบันไดไปวิเคราะห์โครงสร้างจุลภาคและชิ้นงาน

ทรงกระบอกไปทดลองสมบัติเชิงกล 

 

ตารางที ่3.3 ส่วนผสมทางเคมขีองเหล็กหล่อเหนียวที่ต้องการ 

เงื่อนไข Bi C Si Mn P S Mg CE 

1 0  

 

3.50 

 

 

2.60 

 

 

0.04 

 

 

0.02 

 

 

0.01 

 

 

0.06 

 

 

4.3 

2 0.003 

3 0.005 

4 0.007 

5 0.010 

 



    49 

 

3.5 การตรวจสอบโครงสร้างจุลภาคและการวิเคราะห์ทางภาพ  
3.5.1 นำชิ้นงานที่ได้จากการหล่อแบบขั้นบันได ทั้ง 5 เงื่อนไขนำมาตัดด้วยเครื่องตัดเหล็ก 

(Cutting Machine) แยกเป็นชิ้นของแต่ละความหนา ตั้งแต่ 4 ถึง 36 มิลลิเมตร จากนั้นผ่ากลาง

ชิ้นงานทุกชิ้น เพ่ือเตรียมนำไปขัด 

3.5.2 นำชิ้นงานที่ตัดแล้วมาขัดด้วยกระดาษทรายตั้งแต่เบอร์ 100 -1200 จากนั้นขัดด้วย

ผ้าสักหลาดโดยใช้ผงอะลูมิน่า 0.3 ไมครอน และ 0.05 ไมครอน ตามลำดับ ดังรูปที่ 3.26 

 

 
 

รูปที่ 3.26 ขั้นตอนการขัดด้วยผ้าสักหลาดโดยใช้ผงอะลูมิน่า 

 

3.5.3 นำชิ ้นงานที ่ข ัดเสร็จแล้วไปกัดกรดด้วย 3% Nital จากนั ้นทำการตรวจสอบ

โครงสร้างจุลภาคด้วยกล้องจุลทรรศน์แบบใช้แสงและทำการถ่ายภาพโครงสร้างใช้เพื่อนำภาพที่ได้มา

ใช้ซอฟต์แวร์วิเคราะห์ทางภาพ  

3.5.4 เมื่อนำภาพมาวิเคราะห์ในซอฟต์แวร์วิเคราะห์ทางภาพ จากนั้นทำการวัดจำนวนกรา

ไฟท์ เส้นผ่านศูนย์กลาง ความกลมของแกรไฟต์ อัตราส่วนพื้นที่ของแกรไฟต์ เฟอร์ไรต์ และเพิร์ลไลต์ 

นำค่าที่ได้มาวิเคราะห์และสรุปผล 

3.5.5 วิธีการวัดจำนวนก้อนแกรไฟต์ เส้นผ่านศูนย์กลางและความกลมของแกรไฟต์  นำ

ภาพถ่ายที่กำลังขยาย 50X เท่า ที่บริเวณใจกลางหน้าตัดของชิ้นงานแต่ละความหนาตั้งแต่ 4 ถึง 36 

มิลลิเมตร มาเข้าโปรแกรมวิเคราะห์ทางภาพ (Image J) ดังรูปที่ 3.27 
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รูปที่ 3.27 โปรแกรมวิเคราะห์ทางภาพ  

 

3.5.6  เมื่อเปิดโปรแกรมแล้วเลือกไปที่ File>Open> เลือกรูปภาพที่ต้องการหาค่าต่างๆ 

จากนั ้นลากเส้นตรงบนรูปภาพ (เส้นสีเหลือง) ให้เท่ากับสเกลบาร์ บนรูปภาพ แล้วเลือกไปที่ 

Analyze>set scale แล้วใส่ค่าต่างๆให้ตรงกับรูปภาพลงไป เสร็จแล้วกด OK เพื่อทำการตั้งค่าสเกล 

แสดงดังรูปที่ 3.28 

      
รูปที่ 3.28  วิธีการตั้งสเกลของโปรแกรมทางภาพ 

 

3.5.7  การวัดเส้นผ่านศูนย์กลางนั้นทำได้โดยลากเส้นจากขอบของแกรไฟต์ไปยังขอบฝั่งตรง

ข้ามกัน ซึ่งโปรแกรมจะคำนวณออกมาให้ในช่อง MinFeret แสดงดังรูปที่ 3.29   

 
รูปที่ 3.29  ผลการคำนวณค่าต่างๆโดยการใช้โปรแกรมทางภาพ 
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3.5.8  จากนั้นวัดจำนวนแกรไฟต์ออกมาเป็น Nodule/mm² โดยไปที่ File > Open > 

เล ือกรูปภาพที ่ต ้องการหาค่าต่างๆ  > Edit > Invert จากนั ้นปรับชนิดภาพเป็น 8 bit และใช้ 

Threshold ในการเลือกพ้ืนที่ที่ต้องการหา ทำการ Analyze particle ดังรูปที่ 3.30 

 

            
                                                

 

 

รูปที่ 3.30 การใช้ซอฟต์แวร์วิเคราะห์ทางภาพ ที่แสดงวิธีการนับจำนวนแกรไฟต์ 

 

3.5.9  การคำนวณความกลมของแกรไฟต์ของซอฟต์แวร์วิเคราะห์ทางภาพ หาได้จาก

สมการทั้ง 2 สมการนี้ แสดงดังรูปที่ 3.26   

 

𝐶𝑖𝑟𝑐 = 4𝜋𝐴/𝑃2    สมการที่ 3.1 

𝑅𝑜𝑢𝑛𝑑 = 4𝐴/𝜋𝑙𝑚
2   สมการที่ 3.2 

 

3.5.10  วิธีการหาร้อยละพื้นที่ของแกรไฟต์ เฟอร์ไรต์ เพิร์ลไลต์ นำพื้นที่ของแกรไฟต์ เฟอร์

ไรต์ เพิร์ลไลต์ ที่ได้จากโปรแกรมมาคำนวณหาร้อยละพื้นที่ของแกรไฟต์ เฟอร์ไรต์ เพิร์ลไลต์ ตามมา

สมการที่กำหนดไว้ดังต่อไปนี้ 

 

%𝐺𝑟 =
𝐴𝐺𝑟

𝐴𝑇𝑜𝑡𝑎𝑙
 𝑥 100   สมการที่ 3.3 

% ∝  =
𝐴∝

𝐴𝑇𝑜𝑡𝑎𝑙
 𝑥 100   สมการที่ 3.4 

 %𝑃  =
𝐴𝑝

𝐴𝑇𝑜𝑡𝑎𝑙
 𝑥 100   สมการที่ 3.5 

3.6 ทดสอบสมบัติเชิงกล 

ภาพถ่ายจริง                     ใช ้Threshold 
Image > Adjust >Threshold 

 

outline 
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 3.6.1  การทดสอบความแข็งของวัสดุ (Hardness Test) 

3.6.1.1 เตรียมชิ ้นงานที ่ได้จากการหล่อแบบขั ้นบันได (Step pattern) ทั ้ง 5 

เงื่อนไขที่ทำการตัดแยกเป็นชิ้นของแต่ละความหนา ตั้งแต่ 4 ถึง 36 มิลลิเมตร  

3.6.1.2 ตั้งค่าแรงกดสำหรับหัวกดแบบริเนลล์ จากนั้นนำชิ้นงานที่เตรียมไว้มากกด 

5 จุด เพ่ือหาค่าเฉลี่ยความแข็งของชิ้นงาน ทำวนไปทั้งหมดจำนวน 25 ชิ้น 

 3.6.2  การทดสอบแรงดึง (Tensile Test) 

3.6.2.1 นำชิ้นงานเหล็กหล่อเหนียวทรงกระบอกขนาดเส้นผ่านศูนย์กลางหล่อ 25.4 

มิลลิเมตร ที่ได้ทำการหล่อไว้ในตอนต้น ไปกลึงให้ได้ขนาดและรูปร่างที่เหมาะสมสำหรับทดสอบแรง

ดึงตามมาตรฐาน ASTM E8 แบบที่ 1 ดังรูปที่ 3.31   

3.6.2.2 เมื่อกลึงจนได้รูปร่างตามมาตรฐานแล้ว นำชิ้นงานไปทำการทดสอบด้วย

เครื่องทดสอบแรงดึงได้ทันท ีทำวนไปทั้งหมดจำนวน 20 ชิ้น 

 

 
รูปที่ 3.31 ตัวอย่างทดสอบแรงดึงมาตรฐานสำหรับเหล็กหล่อ  

 

3.7 การย้อมสีโครงสร้าง 
3.7.1  วัสดุที่ใช้ในการย้อมสี 

1) ชิ้นงานเหล็กหล่อเหนียว ความหนา 36 มิลลิเมตร จำนวน 5 ชิ้น 

2) โซเดียมไฮดรอกไซด์ (NaOH) 80 กรัม 

3) โพแทสเซียมไฮดรอกไซด์ (KOH) 20 กรัม 

4) กรดพิคริก 20 กรัม 
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5) น้ำ DI  200 มิลลิลิตร 

 3.7.2 ขั้นตอนการย้อมสีโครงสร้าง 

3.7.2.1 ชั่งสาร NaOH 80 กรัมและ KOH 20 กรัม เตรียมไว้  

3.7.2.2 ตวงน้ำกลั่น 200 มิลลิลิตร นำ NaOH 80 กรัม เทลงในน้ำกลั่น ค่อยๆเทที

ละนิดแล้วคนให้ละลาย เมื่อ NaOH ละลายหมดแล้วให้เท KOH 20 กรัม ลงในน้ำกลั่น แล้วคนจนกว่า

จะละลายทั้งหมด จากสีขาวขุ่นจนใส 

3.7.2.3 ชั่ง Picric ประมาณ 20 กรัม แล้วค่อยๆ เทลงในบีกเกอร์ที่ละลาย NaOH 

ผสม KOH แล้ว คนจนกว่าจะละลาย  

3.7.2.4 เปิด Hot plate แล้วตั้งอุณหภูมิให้อุณหภูมิกรดถึงประมาณ 120 ํC ใช้

เทอร์โมมิเตอร์คอยวัดอุณหภูมิกรด ในระหว่างที่มีความร้อนเกิดขึ้นหาฟอยล์อะลูมิเนียมมาปิดปากบีก

เกอร์ไว้ เพ่ือลดการระเหยของน้ำ เพราะกรดมันจะเดือด 

3.7.2.5 เมื ่อทุกอย่างละลายหมดแล้วกรดจะเป็นสีน้ำตาลเข้มตามภาพที่ 3.32 

อุณหภูมิกรดถึงประมาณ 120 ํC แล้วให้นำชิ ้นงานจุ่มลงไป พยายามอย่าวางลงไปก้นบีกเกอร์

เนื่องจากมันมีตะกอนของสารที่ละลายไม่หมดอยู่ซึ่งจะทำให้งานสกปรก จุ่มชิ้นงานลงไปประมาณ 

120 วินาที จนผิวหน้างานออกเป็นสีตามที่ต้องการ 

3.7.2.6 นำชิ ้นงานไปล้างน้ำ และแอลกอฮอลล์ แล้วเป่าให้แห้ง จากนั ้นนำไป

ตรวจสอบโครงสร้างจุลภาค 

 
รูปที่ 3.32 สีของกรดก่อนจุ่มชิ้นงาน 

3.8 การวิเคราะห์ด้วยเคร่ืองวิเคราะห์ไมโครโพรบอิเล็กตรอน (Electron Probe  
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Micro Analysis; EPMA) 
3.8.1 เตรียมชิ้นงานที่ได้จากการหล่อแบบขั้นบันได ความหนา 36 มิลลิเมตรและมีการเติม

บิสมัท 0.005% นำไปตัดให้ได้ขนาด 1x1x1 เซนติเมตร  

3.8.2 แล้วนำชิ้นงานมาขัดด้วยกระดาษทรายตั้งแต่เบอร์ 100 -1200 จากนั้นขัดด้วยผ้า

สักหลาดโดยใช้ผงอะลูมิน่า 0.3 ไมครอน และ 0.05 ไมครอน ตามลำดับ ดังรูปที่ 3.33 

 
รูปที่ 3.33 ชิ้นงานที่ใช้สำหรับวิเคราะห์ด้วยเครื่อง EPMA 

 

3.8.3 นำชิ้นงานที่ขัดเสร็จแล้วไปกัดกรดด้วย 3% Nital จากนั้นเป่าชิ้นงานให้แห้งสนิท 

เพ่ือไม่ให้เกิดสนิมบนผิวชิ้นงาน 

3.8.4 นำชิ้นงานที่เตรียมไว้ไปทำการวิเคราะห์ด้วยเครื่องวิเคราะห์ไมโครโพรบอิเล็กตรอน 

(EPMA) เพื่อสังเกตการกระจายตัวขององค์ประกอบในโครงสร้างจุลภาค เกณฑ์ที่ใช้ในการทดลอง 

EPMA แสดงดังตารางที่ 3.4  

 

ตารางที่ 3.4 พารามิเตอร์สำหรับการทดลอง EPMA 

 Parameter 
Acceleration volage 15 kV 
Beam size 1 mm 
Current 7.5 nA 
Measuring time 10 msec 
Step size 0.4 mm 
Total area size 410d x 307 mm 


